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General Information

BR-Receipts processes receipts by reading the information from scanned images and categorizing it
using field recognition. You can edit, view items and track expenses by building and maintaining a
database of all the information.

Test STORE
ANY TOWN
§55-555-5555

STORE: 00401 REGISTER: 002
CASHIER: Sam
ASSOCIATE: 00000018619

CUSTOMER RECEIPT COPY
CUSTOMER NUMBER: 10312547175999

FIRST PRODUCT
508214-006 1 @ 12.99
SECOND PROOUCT
807469-002 1 & 14.99

THIRD PROOUCT
505453-033 1 @ 22.99

(QSearch L
SR N~ el

B S @ Total Amount: $0.00 Sales Tal
v {41 Test Store V¥ RecoiptDate Vendor  Catogory  Payment Type
3 InBox 09/04/2014 15 ZONE Cash

Edit Items. °

| Verified _| Reimbursable

Receipt Date 09/04/2014 8 Category | -
Vendor |15 ZONE >

Payment Type Cash 52 Purpose Business -
Amount | $0.00 Sales Tax ($2,013.00

Comments
Created Date: 09/04/2014 09:37:30 Modified Date: 09/04/2014 09:37:30

|eslEe O————0



Features

Import receipts from files to build and maintain a database of all the information.
Export receipt images or data to the cloud from BR-Receipts.
Scan receipts to keep detailed records.

Apply an existing template or create a new template to batch process receipts when
importing or scanning.

Read the information and categorize the data by field recognition.

Create reports to view and track expenses.

System Requirements

Computer

Scanner

Receipts

Operating System For Intel-Mac (Intel Core Duo processor), Mac OS X 10.6,
10.7, 10.8, 10.9, 10.10, 10.11 and 10.12.

A minimum of 512 MB free hard disk space for installing the program.
A USB port for scanner connection.
A USB port for computer connection.

Receipts must be in reasonably good condition to be readable by the scanner.



Overview

The following descriptions and instructions will help you get started:

1. Create a Receipt Box
Create a receipt box to build a database of your receipts. You can import, scan, manually create,
and paste receipts into the receipt box.

2. Scan
Put the receipt in the scanner and begin scanning. The scanning progress bar displays the
scanning status.

3. Use a Template
If your receipts have common information, such as where they originated, how goods and
services were paid for, and who is responsible for them, you can use a template for batch
processing. For more information, see Using Receipt Templates.

4. Field Categorizing
Use the field categorizing feature to sort receipt information using field recognition. Click % in
Image View, drag a rectangle to highlight a section of the receipt, right-click the selected receipt
section and select the field type: Receipt Date, Amount, Sales Tax, Vendor, or Payment Type
(or drag the selected section directly to the desired field) to activate field recognition. A dialog box
will ask if you agree with the OCR results. Click OK to add the results to the desired field, or click
Cancel to discard the results and try again.

5. Export To
You can save specific receipts or all the receipts in a folder as a file in CSV, PDF, QIF, or the
QuickBooks (IIF) format. Use the file format best suited to your needs.

[ _]
a. Click “'_'J on the toolbar, or select Export to File from the File menu, to open the Export
to File dialog box.

b. Select All Receipts or Selected Receipts to control which receipts will be exported.

c. Click Settings to set up the export style. The Export dialog box will display the file type
(only applies to CSV format).

e Include a header line - Select Include a header line to have the field names exported.
e Header Language - Select the header language from the list.
e Encoding - Select a type from the list to specify a file encoding format.

e Delimited by - Under Delimited by, select Comma, Tab, or Space to choose the
character that will separate fields in the exported file.

e Select with double quotes to have the information for each field enclosed in quotation
marks.

d. When you select export to QIF, a dialog box will open to let you manage Quicken Accounts
first. You can import available Quicken accounts, or you can edit or delete accounts. When
the Quicken accounts are ready, enter a file name and click Continue to finish.

NOTE: In order to export to a QIF file, you must first create a QIF file using the Export to QIF setting in
Quicken.




e. When you select Export to QuickBooks, you must enter Debit Account and Credit Account
details to continue.

Export to Cloud
To export to cloud, do one of the following:

¢ Right-click a receipt box or folder and choose Export to Cloud from the context menu.

|'F}- \f}

e Select a receipt box or folder and click (_TH—‘ on the toolbar.

e Choose Export to Cloud from the File menu to open the BOL login dialog box.
Enter an email address and password to connect your Brother Online (BOL) account, &
appears, indicating that you can now send receipt images to the cloud from your local computer.

You can click % to monitor the uploading status. When you export successfully,ﬂ will appear in
the status bar.

NOTE: If you select a receipt box to upload, all the folders in this receipt box will be uploaded.

7.

8.

Create Reports
Reports let you see where receipts originated, how goods and services were paid for, and who is
responsible for receipts. For more information, see Creating Reports.

Set up the Quicken to import a file provide by BR-Receipts

NOTE: Quicken supports importing BR-Receipt data into a cash, business or investment based
account.

Before starting, open Quicken and select Start from a .QIF file exported from another application.

@ Quicken IZCW Edit View Transactions Accounts Budgets Window Help

Let’s get started

Save a Backup...
Restore from Backuph. Start from scratch

Get Info

Set File Password... Start from a Quicken Mac 2015 file

Import
Export
Export Tax Report...

Start from a Quicken Essentials file

Page Setup... Start from a Quicken Mac 2007 file

Start from a Quicken Windows file

I © Start from a .QIF file exported from another application I




9. Import a file provided by BR-Receipts into Quicken using the QIF format.
a. Specify the QIF file exported from BR-Receipt by selecting Import the .QIF file
b. Press Next button to import.

c. Below messages will appear after the process is done

This Intuit ID was used with another file

Quicken will reassign this Intuit ID to the current file.
Any other file using this Intuit 1D will no longer sync
and update Quicken connect accounts.

Successfully Imported File.

An import log has been placed in your logs folder.
To view at any time select:
Help > Show Logs in Finder



Getting Started

From the BR-Receipts screen, you can view file folders, a list of all receipts, an image of the selected
receipt, and the recognized data. You can control which receipts are displayed in the list by clicking
the All drop-down list W -l and selecting Recently Added (receipts updated in the last
three days), or Unverified.

‘ Presto! Receipts File Edit View Receipt Help

" stst LAl :) (Qsearch )
& & @ Total Amount: $0.00 Sales Tax: $2,013.00 Reimburse:$0.00 - 8 N = I |-
v () Test Store W ReceiptDate Vendor  Category  PaymentType Sales Tax mount  Purpose  Reimburse
(1 1nBox 09/04/2014 15 ZONE Cash $2,013.00 [i0.00  Business
7 New Fold
®

©—

second pacouct
07463-002 18 14.99

Tz proovcr
505453-033 1. 22.99

Edit Items o

(| Verified || Reimbursable
Receipt Date 09/04/2014 8] Category I Thanks For shopping Test Storel
Vendor |15 ZONE [x
Payment Type |Cash . Purpose Business 2
Amount 50,00 N Sales Tax (52,013.00
Comments
Created Date: 09/04/2014 09:37:30 Modified Date: 09/04/2014 09:37:30

)

e_ B S A | O °

The Menu bar provides the commands you use to perform program functions within BR-Receipts. For
more information, see the Menu Commands section.




Command Toolbar

The Command toolbar displays the most commonly used commands. Click an icon to execute the
command.

Scan Import: Scan receipts to the currently selected folder.

]

NOTE: This feature only applies to folders.

File Import: Import receipts to the currently selected folder.

NOTE: This feature only applies to folders.

ul-:H Export: Export receipt images to file.

IE-J Report: Create a data report for the selected receipts.

Settings: Enter your BOL account information, user profile and defined field values
e to personalize your program and provide easy access when you upload scanned
receipt images.

Export to Cloud: Enter an email address and password to log in and select a receipt
box or folder, then send scanned receipt images to the cloud from your local
computer.

NOTE: If you select a receipt box to upload, all the folders in this receipt box will be
uploaded.

BR-Receipts Website: Click to open the BOL webpage and view the files you have
uploaded, if the account information is not saved in the Settings, you will have to
' enter the account information first.



Folder View

Folder view includes a Folder section and a Search section.

Click the Folder tab to view the Folder section, where you can create a receipt box, open a file, and
create a new folder.

Click the Search tab to view the Search section, where you can select a category and fill in the
keyword, receipt date, amount, and vendor fields, and then click Start Search to find a specific
receipt.

Right-click the blank area to view these commands:

New Receipt Create a receipt box.

Box...

Open Receipt Open a receipt box that already exists.
Box...

Right-click a receipt box to view these commands:

New Folder Create a folder.

Rename Box Change the name of the receipt box.

NOTE: The receipt box name can be no more than 150 characters.

Save As... Save the receipt box under another name.

Set Location Choose a receipt box location from the menu.

Close Close the receipt box and all the folders under it.

Export to Cloud Enter an email address and password to log in, select a receipt box,

and send the receipt image to the cloud from your local computer.



Right-click a folder in the Folder section to view these folder commands:

Scan Receipt... Scan receipts to the currently selected folder.
Import Receipt Import receipts to the currently selected folder.
Images...

Manually Create a  Create a new receipt and save it as a record.
New Receipt

Paste Receipt Paste a copied receipt to a folder.

Verify All Mark the folders as having been edited and approved.
Mark All as Mark the folders as not having been edited and approved.
Unverified

Change the name of a folder.
Rename Folder

NOTE: The folder name can be no more than 184 characters.

Delete Folder The folder and all of its contents will be erased from the database.

Export to File Save specific receipts or all receipts in the folder as a file in CSV,
P PDF, QIF, or IIF format.
Create Report... Choose folders and generate reports.

Enter an email address and password to log in, select a receipt box,

Export to Cloud and send the receipt image to the cloud from your local computer.

Status Bar

The Status bar displays the current number of receipts, the unverified receipts and the processing
status when you upload files to BOL.

To view status when you upload receipt images or data to the cloud, click & When you export a file
successfully, o appears in the status bar.



List View

The List View window displays information about the selected folder. It displays the receipt data in
columns as three totals: Total Amount, Reimburse, and Sales Tax.
Each receipt will be listed along with the data. To search for a receipt, type a keyword in the search

bar |A5ear , press the Enter key and the best-matched receipts will be listed. Click on
a record to select it, or hold down the Shift key while clicking to choose multiple records. The first
selected receipt will be displayed in the image view window. You can drag receipts to other folders.

Right-click a receipt to see these commands:

Cut Copy and remove the selected receipt.

Copy Copy the selected receipt.

Paste Insert the contents of the clipboard.

Delete Delete the selected receipt.

Verify Mark the receipt as having been edited and approved.
Mark as Mark the receipt as not having been edited and approved.
Unverified

10



Image View

The Image View window displays the selected receipt. You can rotate the image before recognition, if
needed.
Use the following commands to refine your images and make the OCR process more accurate:

Move: Click & to move the image.

Crop the image: Click ﬂ, select a portion of the image, and when the pointer changes to a
scissors icon, click it. The image will be cropped.

Deskew image: Click - to rotate an image by any degree.

Rotate image: Click .E] to rotate an image clockwise 90 degrees.

Recognize the field: Click £ and drag a rectangle to select an area, right-click the selected
area to select the field type and perform OCR on the selection.

Undo: Click Q) to undo the last operation performed on an image file.
Redo: Click QY to redo the last operation performed on an image file.

Switch Image: Click @ to switch between the clean image and the original image.

Zoom In or Zoom Out: Use the slider |2 =O 9, to change the magnification of
the image.

Fit to Width: Adjust the image to match with the width of the page.
Fit to Page: Adjust the image to match with the height or width of the page.

Right-click on an empty area to view these commands:

Zoom In Increase magnification.
Zoom Out Reduce magnification.
Fit into Window Adjust the image size to the current window.

Rotate left 90

degrees

Rotate right 90
degrees

Rotate an image counterclockwise by 90 degrees.

Rotate an image clockwise 90 degrees.

11



Edit View

To edit the receipt, do one of the following:
e Click Edit Items from the View menu.
e Double click a receipt.

e Click ® inthe bottom of the List View section.
The Created Date and Modified Date cannot be edited.

12



Working with BR-Recelpts

BR- Receipts is designed to help you organize and track your expenses. Once you start scanning and
saving your receipts, use these basic functions to keep your database current.

Setting Up BR-Receipts

(o
Tt
[~ - ]

Click “*" on the toolbar or click the BR-Receipts menu and select Preferences..., and then enter
your BOL account information, user profile and defined field values to personalize your program.

General: Type your email address and password, select Save Password and then click OK to save
the account information, providing easy access when you send receipt images to the cloud from your
computer.

800 Settings

User Profile User Defined Field  Appearance |

_ BOL Account

E-mail: | mac@newsoft.com.cn v | | Delete |

Password: |ses

E] Save Password [ oK |
|| Use a proxy server for this connection:
Address: Port:
User Name:
Password:

_ The default Receipts Box access folder

JUsers/dragon/Documents /Receipts_Data | Browse

| Close |

13



In addition to uploading from your computer, you can add a proxy to upload your receipt images or
data. Select Use a proxy server for this connection, and then type the proxy address, user name,
password and port to enable the proxy.

Click Browse to specify a receipt box path. When you create a receipt box, the receipt box will be
placed under the path specified in the Settings. When you open a receipt box, you can open the

receipt box under the specified path, and the next time you start BR-Receipts, the default receipt box
path will be the path specified.

User Profile: Type your user information to speed up future searches.

8 00 Settings

| General User Defined Field = Appearance |

First Name | Last Name
Street

City Zip

Work Phone Mobile

Fax Email

Company Name
Title

Web Address

Close

14



User Defined Field: Select a receipt box and choose a type of field you want to update. The items
under the selected type will be displayed as a list.

enn Settings
| General | User Profile [FUlE=elaiy=il=llM] Appearance |

Select a Box | 2222 =

Select a Type | Category 2
| Add |
Fuel/Auto
General Retail | Edit |
Crocery Store
Insurance | Delete |

Lodging/Hotel
Meals /Restaurant
Phone/Telecom
Postal/Shipping
Software /Hardware
Transportation
dsasdfadf

| Close |

e Click Add to open a dialog box, type the item name, and click OK to add the item to the
selected list.

e Click Edit to change an item name in the selected list.

e Click Delete to remove an item from the selected list.

15



You can add an item to a type list and define it as belonging to this type, then similar field content will
be categorized to this type when encountered during field categorizing. For example, you can add
Credit Card to the Display name of Payment Type list, so that when the keyword Credit Card is
recognized during field categorizing, it will be placed under the Display name of Payment Type field.

To import a CSV file that contains multiple items, click the File menu and select Import User Defined
Field.

Appearance: Select a location for easier management.

8 00 Settings

| General = User Profile  User Defined Field

Select Location:

United States

i

Currcecy: §

13

Date Format: MM/DD/YYYY

Close

Select Location: Select a location to set up the currency type and date format for your receipts. For
example, if you select United States, the currency unit will be US Dollars $, and the date format will be
mm/dd/yyyy. When you create a receipt box, the currency type and date format of the receipts in this
box will be formatted based on the selected location. You can change the location by right-clicking the
receipt box and choosing Set Location.

Collecting Receipts

Use your scanner to digitize receipts and store them in a database. Receipts can also be added from
another database, or from image files.

16



Scanning Receipts

For the most powerful results when using BR-Receipts, it is important to configure your folders

properly.

1. Click the File menu and select Scan Settings....

2. Choose your preferred scanning style:

Select Scan with TWAIN user interface if you want to use the scanner's TWAIN interface for
scanning.

enn

Scan Settings

Select Scanner

Brother TWAIN

(_)Scan with TWAIN user interface

\E) Quick scan

_ Default Settings

_ Dptions
Language: | English (United States) % |
Orientation: Auto Detect

Automatically crop the receipts
Display the last receipt imported or scanned

Resolution: | 300 :
| Settings... |
Image type: | Color
_ Brightness and Contrast
) 0 =)
_ Scanning Area Q N
|| Carrier Sheet Mode O ) ] |51
Scan Size: | Auto Detect
_ Scanning Options
Width:
[gEnabIe Document Feeder
Height:
Unit: inches Receipt Position{ADF only): IM
| Cancel || oK

Select Quick scan (the default setting) to have scanning begin as soon as you click OK. Quick
Scan uses the settings defined in this screen, as follows:

Resolution: 300 dpi (dots per inch) will have the best recognition performance in most
cases.

Image type: The default setting is Color. Set the Image type to Gray when scanning
black and white receipts.

Carrier Sheet Mode: Select Carrier Sheet Mode when scanning a receipt in a Carrier
Sheet, Scan Size, Width, Height and Unit fields are unavailable when using a Carrier
Sheet.

17



NOTE: When you select "Carrier Sheet Mode", the software automatically skips scanning the header
of the carrier sheet. The width of the header depends on the scanner you are using. If you are
scanning a long receipt, fold the receipt to fit to the carrier sheet with title and total amount items
shown. Do not skew the paper when folding.

-~ v
& Bp || O Bop |

Joy Sound ‘ Joy Sound ‘

Total Amount Total Amount

NOTE: Carrier sheets may differ depending on your scanner model.

e Scan Size: The default setting is Auto Detect. Select User Defined from the
drop-down list to customize the width, height, and unit.

e Orientation: The default setting is Auto Detect. Click Settings... to select other
options from the list.

e Enable Document Feeder: Select this check box if you want to use an automatic
document feeder (ADF). To use this option, the selected scanner must have an ADF
function.

e Receipt Position (ADF only): Select Left, Right, or Center from the drop-down list if
you want BR-Receipts to tell you where you have placed the receipt in the scanner’s
document feeder.

e Brightness and Contrast: Drag the sliders to adjust the contrast and brightness of the
scanned image. Threshold: When you select Black/White from the Image Type
drop-down list, the threshold slider will appear.

3. Click OK.

NOTE: The settings may differ depending on your scanner, and some features are only available for
specific scanners.

When you finish configuring your scan settings, you can start scanning receipts.

18



4. Put a receipt into your scanner. If you have several drivers available, click the File menu and
select Select Scanner..., and then specify a driver for your scanner from the Select Scanner
dialog box.

5. Click the File menu and select Scan Receipt... (or right-click a receipt box in the Folder View
section and select Scan Receipt...).

6. The Choose template screen will open. Select a template or create a new template to
batch-process your receipts. For more information, see Using Receipt Templates.

[ |

7. When the scanner finishes scanning the receipt, you can click i.; in Image View and drag a
rectangle to select an area, right-click the selected area and select the field type from Receipt
Date, Amount, Sales Tax, Vendor and Payment Type, (or drag the selected area directly to the
desired field) to recognize it.

Importing Receipts

You can import receipts saved as image files.

1. Click the File menu and select Import Receipt Images... (or right-click a folder in the Folder View
section and select Import Receipt Images...).

2. Inthe dialog box, select one or more image files to import, choose the receipt language from the
drop-down list and click Settings to open the Options dialog box to configure your receipts before

importing.
006 Import Receipt Images
= Imi || =+ || (] EN_US_Epson | (Q
FAVORITES _| RT_EN_US_001_3 copy 2.jpg
."%’ All My Files . RT_EN_U5_ 001 3 copy 3.ipg

5

RT_EN_U5_001_3 copy 4.jpg

# Applications eiptApp.xls || RT_EN_US_001_3 copy 5.jpg =
e e 00 Options
[ Public
%1 Documents Orientation: | Auto Detect | Us_noz
0 n .ipg
© Downloads [ Automatically crop the receipts .
B Movies [EIDispla\«r the last receipt imported or scanned
JJ Music 12 4:37 A
l ——————  [12437p
£ Library | Cancel || oK | Pt
Pictures
Options
Language : | English (United States)
Orientation :  Auto Detect

Automatically crop the receipts
Display the last receipt imported or scanned

| cancel | [ Open |

e Auto Detect: Select to have BR-Receipts check to see how the receipt is positioned.

¢ Rotate left 90 degrees/Rotate right 90 degrees: You may need to rotate the scanned
receipt images before recognition.

e Rotate 180 degrees, or Do not rotate: If your receipts are displayed upside down, you
can rotate them 180 degrees. If the images are correct, select Do not rotate.

19



The three options above are in the Orientation drop-down list.

e Automatically crop the receipts: Select to have BR-Receipts crop images
automatically during importing.

e Display the last receipt imported or scanned: Select to display the last receipt
imported or scanned. If this option is not selected, the most recently opened receipt will
be displayed.

e Click OK to finish.

3. Click Open, the Choose template screen will open.Select a template or create a new template to
batch-process your receipts. For more information, see Using Receipt Templates.

4. The image data will be added to the current receipt database.

Creating Receipts Manually

If your receipt is not in good condition or is unreadable by the scanner, you can manually add the
receipt record to the database.

1. Click the Receipt menu and select Manually Create a New Receipt, (or right-click a receipt box
and select Manually Create a New Receipt). A set of empty fields will open in Edit mode,
allowing you to enter text.

2. In Edit view, you can select or type receipt information in each field to create or reconstruct the
receipt.

Using Receipt Templates

If your receipts share common data such as where the receipts originated, how goods and services
were paid for, and who is responsible for them, you can use a template for batch processing.

Atemplate consists of a top area (the top part of the receipt), and a bottom area (the lowest part of the
receipt).

When you scan or import receipts, a dialog box will open to ask if you want to apply an existing

template, create a new template, or manually enter the receipt information. You can choose a different
command for each receipt.
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Select Vendor

Select a template from the vendor folder in the left pane. Select a template style and click OK to
apply it to your receipt.
800

Choose template

(#) Please select a vendor:
~ _ Move the orange rectangle up
Test STORE
18 ZONE — N/A and down so that the little color
2 Abercrombie&Fitch > 555-555-5555 windows are on the right position
(! ALBERTSONS > * e on of the expense data.
— Bed Bath & Beyond > CASHIER: Sam
L] Best Buy > ASSOCIATE: 00000018619 Vendor
() Burger King > A
CUSTOMER RECEIPT COPY Receipt Date
evs s CUSTOMER NUMBER: 10312547175999
@8 DFs > Payment Type
— - FIRST PRODUCT 12.99
- FD”?’"" Donuts . 508214-006 1 @ 12.99 [ salesTax
@8 Fry's
2 H Mart > SECOND PRODUCT 14.99 ] Amount
e 807469-002 1 @ 14.99
2] Home Depot 4
3 IKEA > THIRD PRODUCT 22.99
3 Kmart » 505453-033 1 @ 22.99
L Macy's »
£ McDonald's >
R SUBTOTAL 50.97
&8 Mitsuwa " SALES TAX 3.06
() OFFICE DEPOT 4 TOTAL 54.03
B SEARS - CASH TENDERED
[ ShopRite > CHANGE sggg
! Sports Authority >
SALES TAX ANALYSIS
CODE RATE% TAXABLE TAX
. LOCAL . X A
() New template =0 0 3208
) Tran: 100786 q&/-;mof.a 4:47 PM
(_)Manually input later
Apply o2l [ vislit us at www. teststore.com
Thanks For Shopping Test Store!
sunm
1061578877740218685569 @
—

You can also move the orange rectangle or the color window separately to accurately match the
correspond units.

8.0.0 Choose I
(8) Please select a vendor:
- e Move the orange rectangle up
Test STORE
Abercrombie&Fitch N/A ANY TOWN and down so that the little color
— ALBERTSONS > 555-555-5555 windows are on the right position
(! Bed Bath & Beyond > of the expense data.
| Best Buy > STORE: 00401 REGISTERT 002
= " CASHIER: Sam
2 Burger King > ASSOCIATE: 00000018619 Vendor
& Cvs >
e CUSTOMER RECEIPT COPY Receipt Date
(5 DFS s CUSTOMER NUMBER: 10312547175999
2 Dunkin'Donuts > Payment Type
~— , FIRST PRODUCT 12.99
- :“;: . . 508214-006 1 @ 12.99 [ salesTax
—] lar
{2 Home Depot > SECOND PRODUCT 14.99 Amount
23 IKEA R 807469-002 1 @ 14.99
=
0 Kmart 4 THIRD PRODUCT 22.99
0 Macy's > 505453-033 1 @ 22.99
{1 McDonald's >
0 Mitsuwa >
a SUBTOTAL 50.97
— OFFICE DEPOT > SALES TAX 3.06
(] SEARS 4 TOTAL 54.03
(! ShopRite > f E“d
(2 Sports Authority > &::G; - (%30:]
() STAPLES 4
SALES TAX ANALYSIS
CODE RATEX TAXABLE
. LOCAL i X
(_)Newtemplate 0\ T ?.??? _______ o
- : 100786 FB/SI/ZOIS :
(_)Manually input later
Apply to all visit us at www.teststore.com
Thanks For Shopping Test Store!
umm
1061578877740218685569
R —— T —




New Template

Create templates to apply to your receipts. Create a different template for each vendor to help
organize your receipts.
1. Click New template.

e n0n Choose
(L) Please select a vendor: Please drag this line to the middle of
the item list area.
» / Test STORE

Abercrombie&Fitch N/A ANY TOWN Drag and drop an area of the receipt,
ALBERTSONS 555-555-5555 right-click the selected area and choose
Bed'Bath&Beyond  »| = Y cmemsmmmmnssemee e oo omemempmeme oo a field type from the drop-down menu
Best Buy gg:;:ogg:‘ REGISTER:: 002 to set the attribute of this area.
Burger King ASSOCIATE: 00000018619
covs L R e e e e e

DFS CUSTOMER RECEIPT COPY
CUSTOMER NUMBER: 10312547175999
Dunkin'Donuts

Fry's FIRST PRODUCT 12.99
508214-006 1 @ 12.99
H Mart
Home Depot SECOND PRODUCT 14.99
A 807469-002 1 @ 14.99
Kmart THIRD PRODUCT 22.99
Macy's 505453-033 1 @ 22.99
McDonald's
Mitsuwa
s SUBTOTAL 50.97
(o] :LE DEPOT SALES TAX 3,06
SEARS TOTAL 54.03
ShopRite
Sports Authorit &AsH TENDERED o 60.00
;OZ; g\” o, CHANGE © *  Vendor 5.97
STAPLES —» e e U |
SALES TAX AxaL  Receipt Date
CODE RATI  Sales Tax TAX

LOCAL 6.0(

(*) New template Amount

(_)Manually input later

Apply to all

Thanks For Shopping Test Store!

w—
1061578877740218685569 ——O—
— ;J

~ °

2. The receipt image will be displayed with a red bar. Click and drag the red bar to separate the top
and bottom areas of the receipt. Drag to select an area of the receipt, right-click the selected
area, and choose a field type from the pop-up menu to verify this area.

3. Set the expense data attributes this way.Drag a rectangle to select an area, right-click the area
and choose a field type. Each data unit must be mapped to a separate field type. If you choose a
data unit that is being used, the previous field type will be removed..

Make sure your selections are accurate for the best OCR results.
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4. When the field verification finished, name the template, add notes to the template, and then click

OK to save it.

800

BR-Receipts

Save this vendor as :

Test STORE

Note

[V Add to vendor list

[

oKk |

Manual Input

Click Manually input later to ignore all the templates. You can manually type your receipt's field

information in Edit view. Check Apply to all, and all the receipts will be imported or scanned without

applying a template.

8.0.0 Choose
() Please select a vendor:
Abercrombie&Fitch » N/A T::;: rmomz
ALBERTSONS 555-555-5555
Bed Bath & Beyond =
STORE: 00401 REGISTER:
Best Buy
CASHIER: Sam
Burger King ASSOCIATE: 00000018619
cvs
DFS CUSTOMER RECEIPT COPY
CUSTOMER NUMBER: 10312547175999
Dunkin'Donuts
Fry's FIRST PRODUCT 12.99
H Mart 508214-006 1 @ 12.99
ar!
Home Depot SECOND PRODUCT 14.99
IKEA 807469-002 1 @ 14.99
Kmart THIRD PRODUCT 22.99
Macy's 505453-033 1 @ 22.99
McDonald's
Mitsuwa
SUBTOTAL 50.97
OFFICE DEPOT SALES TAX 3.06
SEARS TOTAL 54.03
ShopRite
Sports Authority cash TEwERED 60.00
STAPLES
SALES TAX ANALYSIS
CODE RATEX TAXABLE TAX
() New template LOCAL 6.000 50.97 3.06
Tran: 100786 08/31/2013 4:47 PM

(&) Manually input later

@Apply to all

(-

Visit us at www.teststore.com

Thanks For Shopping Test Store!

1061578877740218685569

—
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Modify Template

To edit the template applied to a receipt, select the receipt, click the Receipt menu, and then select
Modify template.

The Modify template screen appears with a template that has been assigned to the selected receipt.

If you have verified an area of this receipt as a field, the field type in the menu list will be unavailable
and cannot be applied to another data unit.

8. .00 Modify 1$ ZONE.template

Selected:

Test STORE r 1
ANV TO L Vendor

555-555-5555

adorster: 002 l:] Receipt Date

3% Payment Type
FIRST PRODUCT 12.99

[ ]  salesTax
508214-006 1 @ 12.99
SECOND PRODUCT 14.99 Amount

807469-002 1 @ 14.99

CASHIER: Sam

CUSTOMER RECEIPT COPY
CUSTOMER NUMBER: 10312547175999

|_THIRD PROOUCT 22.99
505453-033 1 @ 22.99
Note:
SUBTOTAL 50.97
SALES TAX 3.06
TOTAL 54.03
CASH TENDERED 60.00
CHANGE 5.97
SALES TAX ANALYSIS
CODE RATEX TAXABLE TAX
LOCAL 6.000 50.97 3.06
Tran: 100786 13 4:47 pm
VISit us at www.teststore.com
Thanks For Shopping Test Store!
L)
1061578877740218685569
—
@ © | Cancel | | Save | | Save as new template
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Delete Template

To delete the template, click the Receipt menu and select Delete template. A dialog box will open.
Click Delete to remove the template from your computer.

800

Delete template

L0 UFFILE UEPU |
. SEARS

. ShopRite

. Sports Authority
. STAPLES

. STARBUCKS

. TARGET

NfA

¥ ¥ ¥y ¥y vy vy "

B Test STORE

. Texaco

. USPS

. Walmart

. Wetzel's Pretzels

. Whole Foods Market

[
[
[
[
[

| Close

[ | Delete |

Apply Another Template

To give your receipt another template, click the Receipt menu and select Apply another template. A
dialog box will open.

8.0.0 Apply another
(») Please select a vendor:
Move the orange rectangle up
5 Bests - .
Bes u;. & /A ANY TOWN and down so that the little color
e Cl\llfsgef ing 555-555-5555 windows are on the right position
>
e f th data.
2 DFS 5 STORE: 00401 REGISTER: 002 R
) 5 CASHIER: Sam

(0 Dunkin'Donuts " ASSOCIATE: 00000018619 [ ] Vendor
3 Fry's >
— CUSTOMER RECEIPT COPY Receipt Date
— H Mart > CUSTOMER NUMBER: 10312547175999
) Home Depot 4 Payment Type
0 IKEA > FIRST PRODUCT 12.99
2 Kmart > 508214-006 1 @ 12.99 Sales Tax
3 Macy's > SECOND PRODUCT 14.99 ] Amount
7 McDonald's > 807469-002 1 @ 14.99
£ Mitsuwa ” THIRD PRODUCT 22.99
(] OFFICE DEPOT 4 505453-033 1 @ 22.99
(20 SEARS >
(1 ShopRite >
(1 Sports Authority > g:::gT:kx Sggg
() STAPLES » T 54,03
() STARBUCKS 4
a CASH TENDERED 60.00
TARGET » CHANGE 5.97
B Test STORE

SALES TAX ANALYSIS

CODE RATE% TAXABLE TAX

LOCAL 6.000 50.97 3.06

New template

Manually input later

Apply to all

Tran: 100786 08/31/2013 4:@7 W)

VISt us at www.teststore.com

Thanks For Shopping Test Store!

1061578877740418685569

—
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Field Categorizing

Field categorizing lets you sort receipt information by field.

Click £ in Image View, drag a rectangle to select an area, right-click the selected area and select
the field type from Receipt Date, Amount, Sales Tax, Vendor, or Payment Type (or drag the

selected area directly to the desired field) to recognize it.
@ 7 = @ | : | =i |

Test STORE
ANY TOWN
555-555-5555

0401 REGISTER: 002
Sam
‘E: 00000018619

RECEIPT COPY
NUMBER: 10312547175999

QDUCT, - -
06 1 8 324 Vendor

- 1 Receipt Date
Sales Tax
Amount
Payment Type

RODUCT
02 1 @ 14.

QoDuUCT
33 1@ 22.99

x

DERED

X ANALYSIS
RATEX% TAXABLE
6.000 50.97

0786 08/31/2013

sit us at wwv.teststore.cc

nks For shopping Test Stor

1061578877740218685569

|==2L| ©@ —(r——©

A dialog box will ask if you agree with the OCR results, click OK to put the results into the desired field,
or click Cancel to discard it.

800 BR-Receipts

Do you want to save the information for Payment Type?

Recognition Results: 0 12.99

| Cancel | [ OK |

When finished, the receipt and the data will be displayed and you can check and edit the data. This is
called the verification process. You can mark a receipt as verified, or you can come back and verify it
later when you have time.
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Editing Receipts

In addition to verifying the receipts, you can also make changes and add comments or other

information. Click the View menu and select Edit Items, (or double-click a receipt, or click # in the
bottom of the List View section. In Edit view, if an item is purchased for others, you can select
Reimbursable to record the charge that should be reimbursed to you.

Searching for Receipts
You can type keywords and specify a category, receipt date, amount, or vendor in the Search section

to quickly find all receipts that match your query. The search results will be shown in List View and
Image View.

Creating Reports

After all of your receipts are entered and edited in BR-Receipts, you can generate reports that will
show the data in an organized way. Select options as described below, and then click Create Report.

1. Click the Receipt menu and select Create Report... (or click #=* on the toolbar or right-click a
folder and choose Create Report...). The Report Wizard appears.

800 Report Wizard

Title:  Expense Report ™ Show Subheader
_ Reporting Type

(*) Expense () Spending

Spending by : | Vendor =
_ Formatting

Page Size:
l?] Include Cover Page
d | A4 (8.3 *11.7) =
l?] Include Receipt
@Include Image
| Cancel || Continue
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Type a title for your report in the Title field. Select the Show Subheader check box to display a
subheader.

The default Reporting Type is Expense. To change to a Spending Report, select Spending.

In the Spending by drop-down list, whatever is selected determines how receipt information is
summarized. For example, if Payment Type is selected, the report information will be
summarized by the payment type in the first field; if Vendor is selected, the report will be
summarized by vendor names in the first field.

In the Formatting section:

Select Include Cover Page if you want a cover page that includes receipt date, user profile and
summary.

Select Include Receipt if you want your report to display groups by spending type, with detailed
information for each group.

Select Include Image if you want the receipt images to be printed in the report.

5. When finished, click Continue.
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Menu Commands

BR-Receipts Menu

About BR-Receipts

Check for Latest
Version

Preferences...
i

Services

Hide BR-Receipts
#H

Hide Others
#H
Show All

Quit BR-Receipts
#Q

Shows copyright information and software version.

Check for the latest product.

Customizes BR-Receipts features.

Starts or stops services.

Minimizes BR-Receipts to an icon on the application bar at
the bottom of the screen.

Minimizes all open programs to the application bar at the
bottom of the screen.

Maximizes all open programs.

Quits BR-Receipts.

29



File Menu

New

Open...
#0

Save As...
&S

Close
Scan Receipt...

Scan Settings...

Select Scanner...

Import Receipt
Image...

Import User Defined
Field...

Export to File

Export Receipt
Image to File...

Export to Cloud

30

Create a new receipt box whose

New Receipt Box ; :
properties you can determine yourself.

Create an empty folder in the selected

New Folder .
receipt box.

Open a receipt box.

Save the selected receipt box with a new name.

Close the selected receipt box.
Scan receipts to the currently selected folder.
Configure the Scan Settings.

Select a driver for your scanner, or a different scanner connected
to your computer.

Import receipts to the currently selected folder.

Import a CSV file with customized items of different types in
multiple fields.

Save the receipts as a file in CSV. PDF. QIF or lIF format or
export your data to a third party application.

Export receipt images to file. The supported file formats are JPG,
TIF, and BMP.

Upload receipt images or data to cloud.



Edit Menu
Cut
# X

Copy
%C

Paste
4V

Delete

Select All
A

Unselect All

Invert Selection

View Menu

Edit Items
Zoom In
Zoom out

Fit into Window

Rotate Image

Cut the selected receipt. (You can choose more than one.)

Copy the selected receipt. (You can choose more than one.)

Insert any copied or cut information.

Receipt
Delete either a receipt or a folder.
Folder

Select all receipts in the current folder.

Cancel all the selection in the current folder.

Select the unchecked receipts in the current folder.

Hide or display Edit View.
Increase magnification.
Reduce magnification.

Adjust the image size to the current window.

Rotate left 90 Rotate the selected image

Degrees counterclockwise 90 degrees.

Rotate right 90 Rotate the selected image clockwise 90
Degrees degrees.
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Sort By

Receipt Menu

Manually Create a
New Receipt

Modify template

Delete template

Apply another
template

Create Report...

Help Menu

Using Help

Link to Brother
Website
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Verified

Vendor

Category

Receipt Date

Payment Type

Sales Tax Sort the receipts by the selected field.
Amount

Purpose

Created Date

Modified Date

Reimburse

Create a receipt in the current folder.

Edit the template applied to this receipt.

NOTE: An error message will appear if the receipt was not applied
to any template, or if OCR is being performed on the receipt.

Remove an existing template from the program.

Choose another template to re-recognize your receipt.

Make a report from the data on the selected receipts.

Show the BR-Receipts Help documentation.

Open the Brother web page.
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